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1 Release Information 

1.1 General 

Release Name 

The release name is Painting PowerPac 2019.5 and build number is 6.10.1011.1039 

This should be used together with RobotStudio 2019.5 onwards.  

The information should be considered only as last minute information. 

Release Date 

The release date is Dec 19, 2019. 

Language Support 

Painting PowerPac User Interface is available in English and German language. 

Documentation 

User documentation for Painting PowerPac is available from the Help button in the 
Painting PowerPac ribbon tab.  

The documentation in PDF format is also available together with the installation 
package. 

1.2 System recommendation 

Recommended Software 

Operating System  

Microsoft Windows 7 SP1 (recommended) 64-bit edition 

Microsoft Windows  10 (recommended) 64-bit edition 

 

Recommended Hardware 

CPU 2.0 GHz or faster processor, multiple cores recommended 

Memory 8 GB if running Windows 64 bit edition (recommended) 

Free disk space 10+ GB free space, solid state drive (SSD) 

Graphics card High-performance, DirectX 11 compatible, gaming graphics card from 
any of the leading vendors. For the Advanced lightning mode 
Direct3D feature level 10_1 or higher is required.  

Screen resolution 1920 x 1080 pixels or higher is recommended 

Colors 256 or higher 

DPI Normal size (100% / 96 dpi) up to Large size (150% / 144 dpi)  

Mouse Three-button mouse 

3D Mouse [optional]  Any 3D mouse from 3DConnexion, see http://www.3dconnexion.com.  

 

1.3 Simulation Models 

Paint Tools 

The following Paint Tool Libraries are made available in the Painting folder of the ABB 
library: 
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Tools 

AGMD_PRO RB1000_WSC_40_700 

CGS500cc RB1000_WSC_50_500 

CGS700cc RB1000_WSC_50_700 

CGS1200cc RB1000_WSC_70_500 

Ecco_70AS_03 RB1000_WSC_70_700 

G1_COPES_02 ROBOBEL625TD 

G1_Direct_Charge_03 ROBOBEL926_T _TD_03 

RB031 ROBOBEL926_WTD_MC_03 

RB1000_EXT_L ROBOBEL951_T_TD_02 

RB1000_EXT_S ROBOBEL951_WTD_MC_02 

RB1000_WSC_30_500 ROBOBEL951_2K_02 

RB1000_WSC_30_700 ROBOBEL1000_SAD_02 

RB1000_WSC_40_500 ROBOBEL1000_SSD_02_70 

RB1000i_EXT_SAD_L RB1000i_EXT_SAD_S 

RB1000_CE_D30L  
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2 What’s New? 

Overview 

This section contains information about the new features of Painting PowerPac 2019.5 
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3 Corrections/Improvements 
                                                               

Overview 

This section describes the corrections/improvements made in Painting 
PowerPac 2019.5 
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4 Known Limitations 
 

Overview 

This section describes the known limitations in Painting PowerPac 

4.1 Painting PowerPac 2019.5 

4.2 Manage Systems 

Non-Paint systems 

Painting PowerPac is designed to work primarily with paint systems, having a non-paint 
system, several functions might not work as expected. 

4.2.1 Manage Modules 

Load Module  

If the module file selected to be loaded into Painting PowerPac has dependency on 
data declared in a different module, the module will not load and will report an error as 
below. 

 

Workaround: Load all dependency module(s) to the RobotStudio Virtual Controller 
Task prior to loading the selected module(s) in Painting PowerPac. 

Copy/Mirror to other Robot 

While copying or mirroring to other Robot, if the selected module has dependency on 
the data declared in different module, then that module will be copied or mirrored with 
the following error: 
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4.2.2 Connect with real robot 

Connecting with robots on the paint line 

While performing operations such as Load Program, Transfer and Edit Brush tables, 
which require to be connected to the robots on the line, it is noticed that sometimes the 
connection is lost while fetching or transferring data. 

Workaround: Disconnect and connect again. If it does not respond, try to close and re-
open RobotStudio. 

4.2.3 Support Functions 

User authentication system configuration 

Some functions in Painting PowerPac extend the similar functions of RobotStudio. 
Hence, to use them with Painting PowerPac, the dependent RobotStudio commands 
must also be selected in the User configuration window. 

Examples: 
Conveyor Jog and Reset 
Simulation Play / Stop / Reset 
Show / Hide 
Insert Move and Action instructions from the context menu. 
Modify WorkObject option from context menu 

 

 

4.2.4 Appending program to Job Queue 

Appending programs to Job queue 

While appending programs to Job queue, sometimes it is noticed that the jobs are not 
getting appended to it.  

 
Workaround: Restart all the controllers (or) Deactivate and Activate the Painting 

PowerPac. 
 

 

4.2.5 Customized Context menu of Workpiece is not proper 

Context menu of Workpiece is not proper 

 If the user switches to [Home] tab, the customized Painting PowerPac context menu of the 
workpiece is not proper. i.e. {New Empty Panel} and some other context menu added to it by 
Painting PowerPac, which does not work properly in Home tab. 

 
 
Workaround: User can switch to [Painting] tab and use those functionalities. 
 

 

4.2.6 ToolTip Information for Target Reachability is not proper  
If the targets are not reachable/reachable with other configuration then proper 

message is displayed at the tooltip. Sometimes, this message is not proper i.e, if targets 
are unreachable/reachable with other configuration, then also marked as reachable.  

  
Workaround: Go to the Robot {Task} and [Refresh] the browser tree.  
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5 RobotWare Compatibility 
   Painting PowerPac 2019.5 is compatible with RobotWare 5.15.xx onwards. 
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6 Installation information 

6.1 Installing Painting PowerPac 

Installation Instructions 

Painting PowerPac2019.5 requires RobotStudio 2019.5. It will be installed side-by-side 
with any previous installation of Painting PowerPac. However only the latest version of 
the PowerPac will be available in RobotStudio, as they share the same Activation key. 

New Installation Path: Painting PowerPac 2019 is installed in C:\Program Files 
(x86)\ABB\Painting PowerPac 2019 (Same as RobotStudio). 

 

How to install Painting PowerPac on a PC 

 Action 

1 Go to the website http://new.abb.com/products/robotics/robotstudio/downloads 

2 Download Painting PowerPac from the PowerPacs section. 

3 Unzip Painting PowerPac 2019.5.zip file, to extract all the installation 
components to the folder specified.  

4 Go to the extracted location. 

5 Double click on ABB Painting PowerPac 2019.5.exe file. Go through the 
wizard to finish installation.  

 

Licensing 

The Painting PowerPac software licenses are designed to cater to the Engineering 
(Office) and Operations (shop floor) requirements. The following licensing options are 
available:  

RobotStudio and Painting PowerPac: 

• Basic (no license required) 

• Premium 

Licenses for Robot Controller: 

• Shopfloor PPP Enabler PaintWare option. (This option is available with 
PaintWare 5.15.14 and 6.06 onwards) 

For more details, see the Operating manual - Painting PowerPac 

Trial license  

PowerPac specific Trial license is not supported by Robot Studio 2019.  

Robot Studio Trial license itself is applicable for PowerPac also. 

RobotStudio Trial License: 

Users need to request a trial license from within RobotStudio, whereby RobotStudio 
connects to a cloud service that provides a trial license key unless a previous trial has 
been granted to that particular machine.   

Only one trial per machine is allowed. Internet connection is required for the trial 

How to activate Painting PowerPac license? 

Use the Activation Wizard to activate your Painting PowerPac installation.  

http://new.abb.com/products/robotics/robotstudio/downloads
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For using the Activation Wizard, follow this procedure. 

 Action 

1 On the File tab, click Options and go to General: Licensing. 

2 On the Licensing page to the right, click Activation wizard to launch the Activation 
Wizard. 

3 In the Activation Wizard, on the Activate RobotStudio page, indicate whether you 
have a Standalone License or a Network License, and then click Next. 
If you have chosen Standalone License, you will proceed to the Activate a 
Standalone License page. See Activate automatically over the Internet or 
manually below for further steps. 
If you have chosen Network License, you will proceed to the Network License page. 
See the RobotStudio Operating manual for further steps. 

Activate automatically over the Internet or manually 

The Activation Wizard gives you two choices on how to proceed. You can choose either 
automatic activation over the Internet or manual activation. These are explained in the 
following section. 

Automatic Activation (recommended) 

In Automatic Activation, the Activation Wizard automatically contacts and sends your 
activation request to the ABB licensing servers over your Internet connection. Your 
license will then be automatically installed and your product will be ready for use. 

For Automatic Activation you need a working Internet connections and also a valid 
Activation Key that has not exceeded the number of installations allowed. 

RobotStudio must be restarted after the activation has been successfully completed. 

 

Manual Activation 

1. If the computer does not have a working Internet connection or a trial license 
needs to be activated, you must proceed with Manual Activation 

2. A license file has an extension “.bin”.  

3. If you already have a license file, follow the step 8. 

4. If you want to create a license file, follow steps 5 – 8. 

5. Create a license file by selecting the option Step 1: Create a license request 
file. Proceed through the wizard, enter your Activation Key and save the 
License Request File to your computer. 

6. Use a removable storage medium, such as a USB stick or floppy disk, to 
transfer the file to a computer with an Internet connection. In that computer, 

    Note 
 

If you have a problem with your activation, contact your local ABB customer 
support representative at the e-mail address or telephone number provided 
at http://www.abb.com/contacts. 

    Note 
 

If you choose to activate over the Internet but are not currently connected to 
the Internet, then the wizard alerts you that there is no connection. 

http://www.abb.com/contacts


Release Notes 
Painting PowerPac 2019.5 

 
© Copyright 2019 ABB All rights reserved 13 

  

open a web browser, go to http://manualactivation.e.abb.com/ and follow the 
instructions given.  

The result will be a License File that should be saved and transferred back to the 
computer having the installation awaiting activation. 

7. Re-launch the Activation Wizard and go through the steps until you reach the 
Activate a Standalone License page. 

8. Under Manual Activation, select the option Step 3: Install a license file.  

Proceed through the wizard, selecting the License File when requested. Upon 
completion, Painting PowerPac is activated and ready for use. 

RobotStudio must be restarted after the activation has been successfully completed. 

How can I tell whether my Painting PowerPac installation has already been activated? 

1. Go to the File tab, click on the Options button, and select the Licensing 
section. 

2. Click View Installed License Keys to see the status of your current license. 

3. If your Painting installation is activated, you will have valid licenses for the 
features covered by your subscription. 

 

http://manualactivation.e.abb.com/
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7 Technical support 

7.1 Overview 

Contacting ABB 

If you have any questions or problems with your PowerPac installation, please get in 
touch with your local ABB Robotics Service representative, or the person who has 
shared this build. 

Have the following in mind  

1. Running the latest version of RobotStudio and Painting PowerPac ensures that 
it works properly and includes improvements and new product functionality. 
ABB recommends that you update to the latest version of RobotStudio and 
Painting PowerPac whenever a new version is available and before contacting 
ABB for support. 

2. Give a brief description of how to reproduce your problem. 

3. Create screenshots if applicable. (Use ALT + PRINT SCREEN to get an image 
of the active window instead of the entire screen.) 

4. Generate a Full Scan with the RobotStudio Support Tool available next to 
RobotStudio in the Start menu, save the report and attach it with your problem 
description. (Click Start → Programs → ABB → RobotStudio2019 → 
RobotStudio Support Tool, click on Run Full Scan and then Save Report.  

5. We also need the following user information: 

i. Name 

ii. Company 

iii. Contact information 

iv. What operating system you are running (incl. language) 

v. Subscription ID for your purchased license. 

vi. Machine ID, see Help section of File tab. 

 

License support 

For license-related questions, please contact the team responsible for license support 
directly at softwarefactory_support@se.abb.com 

    Note 
 

When sending large (> 1 Mb) files, please compress them with WinZip® or 
WinRAR. 

mailto:softwarefactory_support@se.abb.com

